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1 Getting Started

Introduction

PortraitPro Body is the easiest and fastest way to re-touch full body portraits, allowing you to achieve
professional results in minutes.

PortraitPro Body works in a completely different way to ordinary airbrushing and warping software - it has been
trained with thousands of examples of human body shape and appearance.

Due to the innate knowledge of human beauty that is built into PortraitPro Body, the highest quality full body
portrait touch-up can be achieved by anyone in just a few minutes.

PortraitPro Body is available in two editions, Standard, and Studio. All editions are covered by this manual.

PortraitPro Body is available for Windows and Mac computers. This manual is for the Windows version of
PortraitPro Body.

Getting Started

Take a look at the Quick Start Guide  to see a quick overview of how to use PortraitPro Body.

The Step By Step Guide  provides more detailed information about each step.

If you need further help, please visit http://www.portraitprobody.com/support/ where you see the latest FAQ, and
access our support ticket system. The support ticket system lets you send a question to our support staff.
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1.1 Quick Start Guide

PortraitPro Body will guide you through the process of enhancing the body of a person in a portrait. You can use
this quick start guide to familiarize yourself with the stages.

When you open PortraitPro Body, you will see the main home page. This page contains numerous videos and
tutorials that will allow you to learn about and try different parts of the software. We would recommend that you
work through some of these components in the suggested order. However, if you want to start working on your
own image straight away then you should proceed as follows:

Select the image to enhance

Click on the New Image button, or select Open... from the File menu, or press CTRL + O. This brings up the file
open dialog where you can select the image you want to load.

PortraitPro Body will load your image and show it in the main working area.

Select the body you want to enhance

Click on the middle of the face of the person you want to enhance. Occasionally the software will fail to identify
the face and will prompt you to mark a second point on the chin.

Select the gender of the person

At the prompt, let the software know if the selected person is male or female.

Mark the skeleton joint positions

The software will now guide you through marking the skeleton joint positions. To mark a position simply click at
the relevant position. If you make a mistake, you can go back to the previous point by right clicking or pressing
CTRL + Z. Examples of the ideal joint positions are illustrated in the help panel on the right-hand side. If the
bone that precedes the current joint is completely hidden in the image (e.g. behind the body or another object)
then you can optionally mark it as obscured by pressing 'h'. This will mean it is given no further consideration by
the software. Pressing 'h' again will restore its original status.

Mark the curves

The software will now help you mark curves around the edges of the arms, torso and legs. Again, you place a
point by clicking at the relevant position. If you make a mistake, you can go back to the previous point by right
clicking or pressing the backspace key. Examples of correctly marked curves are illustrated in the help panel
on the right-hand side.

Identify overlaps 

Sometimes the software needs further help in detecting which limbs are in front of which others. If this is the
case, then you will be presented with two alternate configurations (e.g. "left arm in front of right arm" vs. "left arm
behind right arm"). Select the correct configuration by clicking on either the left or the right image.

The software will now prompt you to finish the markup stages and edit the image. Alternatively, you can go back
to any of the preceding markup stages.
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Shape sliders section

The image is now ready to edit with the shape sliders  section. You can change the shape of the body by
moving the sliders on the right-hand side. By opening the sections for torso, arms, or legs you can modify more
specific parts of the body. Collectively these sliders allow a very fast method for getting the shape of the body
roughly correct. You can see the image before and after the changes by pressing ENTER or by clicking the tab
above the main image.

Shape tools section

Select the shape tools tab on the right-hand side. These tools allow you to make finer changes to the shape of
the body. The (default) drag curves  tool allows you to directly use the mouse to drag the body contours to
new positions. You can also drag the joint positions to change the pose of the body. Other tools in this section
include:

o the drag tool  which allows you to drag any region of the image to warp it.

o the repair tool  which fixes any problems or tears in the image introduced by the other tools.

Other editing sections

Other parts of the software (selectable by clicking in the control column) can be used to modify other parts of
the image:

o the skin section  allows you to smooth the skin on the body and also to improve the texture of the belly
area.

o the face section  allows you to airbrush and reshape the face to improve the appearance. (PortraitPro is
a standalone product that is specialized to this task and has many more options.)

o the picture section  allows you to change global aspects of the whole image such as contrast and color
balance.

o the warp fixer  allows you to fix lines and other areas that have become distorted due to the body
warping.

Save project and image

When you are happy with the changes you have made, you can save the edited image, using by selecting
"Export Final Image" from the "File" menu, or by clicking the appropriate icon from the toolbar at the top of the
control column. You can save the entire project (with file extension .prb) by selecting "Save Project" from the
"File Menu" or by selecting the appropriate icon from the toolbar. This will allow you to return to this image and
make further changes at another time.

Other people in the photo

If there is more than one person in the photo that you wish to edit, save your image and close the session, then
open the saved image and select the next person to enhance.
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1.2 Top Tips For Best Results

If you just read one page in this manual, make it this one to get the best results out of PortraitPro Body.

Make sure the skeleton joints and curves are accurately placed

You will get the best results if the outlines are accurately placed. Take a close look at the examples in the help
window on the right-hand side of the workspace. You can return to the markup stage to improve the markup at
any time (although you will lose all changes to the body). Take particular care to ensure that the outlines around
the outside of the body follow the edge of the body.

Don't move the sliders too far

Often, you can greatly improve a picture with fairly subtle changes. Adjust the sliders just far enough to get the
results you want. If you go too far, the result can look unnatural or fake.

Don't use the sliders to make small shape changes

You can avoid the need to move the sliders too far by using the shape tools to make finer-scale changes to one
particular part of the body.

Fixing problems

You can fix regions that are torn or unrealistically warped using the repair tool  in the shape tools section. If
the warps to the current body make unrealistic changes to the background, the repair tool can also be used to
fix these problems.

Make sure the skin area is right

In the skin section , PortraitPro Body automatically estimates which areas in your picture are skin. However,
you can sometimes improve the results by adjusting the skin area selected.

Use the skin select and deselect tools to paint over any skin areas that are wrong.

Fixing distorted backgrounds

If the background is significantly distorted after warping the image, you can fix it with the repair and revert tools
.
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1.3 PortraitPro Body Editions

PortraitPro Body comes in two editions, Standard, and Studio. The Standard edition is intended for more casual
users or amateur photographers. The Studio edition is intended for enthusiast or professional users.

This manual covers all editions, with features that are only available in some editions are indicated like this: 
Studio Edition Only

The following table shows the main features of PortraitPro Body and which editions they are in.

Standard Studio

  Available as a smart filter in Photoshop

  Available as a Lightroom External Editor

  Read camera RAW format

  Read Adobe DNG format

  Read & write TIFFs and PNGs containing 16 bits per color

  Support for JPEG, PNG and TIFF embedded color profiles

  Supports conversion between different color spaces

  Body shape editing

  General warping tools

  Skin smoothing

  Stomach replacement

  Eye enhancing
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  Face sculpting

  Face smoothing

  Warp fixer

  Picture control tools

  Read and write JPEG, PNG and TIFF format images

  Lite mode

  Free online support
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2 Step By Step Guide

This section of the manual describes the various stages that you may need to go through when you use
PortraitPro Body.

There are two parts of the program:

o  in the markup stages , the image is annotated by the user with the joint positions and curve positions.

o  in the enhancing stages , the image is manipulated to create the desired effects.

2.1 Open an Image

The PortraitPro Body Home Screen

When you run PortraitPro Body, it begins with the home page:

Open a single image

To open an image to enhance:

o Select the Open command in the File menu .

o Alternatively, click the button marked "open".

This will bring up the Open Image or Project window.

53
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Browse to the file you want to enhance and press the Open button.

Image types that PortraitPro Body can open.

2.2 Open an Image in Lite Mode

Lite mode allows you to make quick adjustments to your image without needing to mark it up. To open an
image in lite mode, select 'open image (lite mode)' from the homepage and choose an image.

You will see the following in the control column:

You can still use the following:

o Some of the shape tools.
o Most of the skin section features (skin is still automatically detected).
o All of the picture section sliders.

Various sections and tools are unavailable since there is no information about the body in the image. If you

88
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decide you want to markup your image later, you can click on the 'markup' section. Note that this will clear any
changes you have made.
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2.3 Plug-in Mode

Using the PortraitPro Body Plug-in

Studio Edition Only

The Studio edition of PortraitPro Body can enter a "plug-in mode". This is intended for use when PortraitPro
Body has been launched by another application (such as Photoshop) to enhance an image that is being
managed by the other application. PortraitPro Body then behaves like a plug-in to the other application.

After the plug-in has been successfully installed as outlined in the Plug-in Installation Guide , you will be
able to use PortraitPro Body as a plug-in in any of the supported photo editing applications.

When PortraitPro Body is run as a plug-in from another application, the image or layer in the other application
will automatically be loaded into PortraitPro Body where you can enhance the bodies in the usual way. Once
you are happy with your results, select Save and Return from the File menu or click the close button on the
toolbar. This will close PortraitPro Body and return the enhanced image to the original application.

When PortraitPro Body is in plug-in mode, the only command in the file menu is return from Plug-in and several
of the toolbar controls are also not selectable.

Using PortraitPro Body from Photoshop

When the plug-in has been installed, PortraitPro Body will appear as a filter in Photoshop. In the Photoshop 
Filter menu, you will find a sub-menu called Anthropics, and in that you will find PortraitPro Body.

The PortraitPro Body filter works like other Photoshop filters in that it is applied to the current selection (or the
whole area if there is no selection) on the current layer. When you select the filter, the image being filtered will
automatically be opened in PortraitPro Body.

Plug-in Location: Filter > Anthropics > PortraitProBody

82
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2.4 Markup the image

Before the image can be edited, we must first tell the software which person in the image we wish to work on,
their gender and the positions of the joints and body curves.

2.4.1 Select the face

After opening the image, the markup process starts.

Throughout the help process, a panel on the left-hand side of the window gives instructions and provides
guidance for unusual cases. This panel can be hidden by clicking on the tab on the left-hand side of this panel
or by using the View menu.

To identify the person that you want to edit, move the mouse over the center of their face (the tip of the nose
works well) and click the image. If the face is identified successfully by the software you will now be asked to
identify the gender.



Step By Step Guide 19

© 2018 Anthropics Technology Ltd.

Occasionally, the software will fail to identify the face based on your click. This often happens when the face is
close to profile or is partially obscured by hair or another object. When this happens, the software will prompt
you to select a second point on the chin of the person you wish to edit. As you do this, an oval will be displayed
and when you have the correct chin point, this oval should roughly surround the face.

Alternatively, the face may not have been detected because you clicked on the wrong image position in the first
stage. If this is the case, you can undo your change by selecting Undo from the Edit menu or using the shortcut 
CTRL + Z.

For further information, consult the select face reference .53
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2.4.2 Choose gender

The next step is to identify the person as being male or female. This is done via a simple dialog box which is
superimposed on the image.

To select the gender, click on the picture of the male or female body.

If you make a mistake, you can return to this part of the program by clicking on "Choose Gender" on the right-
hand side panel.

2.4.3 Mark skeleton joints

The goal of the third markup stage is to identify where the skeleton of the person is. The joints are marked in
one after another, in a predetermined order. To mark a joint position, simply click on the appropriate point in the
image. The cursor will then jump to the next point.
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If you want to go back and change the position of the point you just marked, you can go back to the previous
point by pressing backspace or right clicking.

The joint positions are added in the order:

o  Right shoulder (on the left side of the image for people facing the camera)
o  Right elbow
o  Right wrist
o  Left shoulder
o  Left elbow
o  Left wrist
o  Belly Button
o  Right hip
o  Right knee
o  Right ankle
o  Left hip
o  Left knee 
o  Left ankle

At each stage, the help panel on the left-hand side shows examples of exactly where to mark the point. In
general the point should be placed in the center of the joint so that the "bones" are aligned along the center of
the limb.

If the joint is outside the image bounds, then simply mark the joint where you think it would be outside the
image boundary.

Other unusual markup situations are covered in the left-hand help panel.

Hidden limbs

The widget on the right-hand panel can be used to mark limbs as hidden. For example, if the arm is completely
obscured by the body or by another object, it could be identified as hidden here.
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When a limb is marked as hidden, it will appear as dashed in the main panel. Alternatively, hitting the H key will
toggle the visibility of the limb that precedes the current point.

Marking a limb as hidden means that it will have no further effect on the proceedings and means that there is
no need to mark the curves of this limb in the next stage. Limbs should only be marked as hidden if they are
completely invisible in the image. If any part is visible (e.g. the top half of the upper leg is in the image, but the
lower half is cut off) then they should not be tagged as hidden.

For further information, consult the mark skeleton joints reference .56
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2.4.4 Mark body curves

The fourth stage of markup is to mark the curves of the body. This proceeds in the fixed order:

o  right arm
o  left arm
o  torso 
o  right leg
o  left leg

When this markup stage is entered, the curve is attached to the mouse cursor. Mark the first point by moving
the mouse cursor to a position on the edge of the limb. The mouse cursor is constrained to stay within a small
rectangle or triangle, so it should be clear which edge should be marked. The goal is simply to place this
particular point on the edge of the limb. Don't worry about whether the entire curve lines up well at this stage --
this will happen naturally as you mark more points.

To fix the point, press the left mouse button. The program will then jump to the next position on the curve. When
you have marked all of the points on the left arm, the software will scroll to the right arm and the process
continues. Points that are on hidden limbs or outside the image are skipped automatically.
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At each stage, the help panel on the left-hand side shows examples of exactly where to mark the curves. This is
mainly straightforward with the exception of marking the torso for women. In this case, the torso curve should
also surround the outside of the breasts.

 
Unusual markup situations are covered in the left-hand help panel.

If you want to go back and change the position of the point you just marked, you can go back to the previous
point by pressing backspace or right clicking.

If you want to move back to a different limb, you can do this by clicking the appropriate number on the right-hand
curve widget, or by pressing using the left and right arrow buttons to move to the next or previous limb.

For further information, consult the mark curves reference .59
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2.4.5 Identify overlaps

For some images, the marked bones and curves overlap one another and the software will quiz you to identify
which limb is in front of which. For other images, where there is no ambiguity then this stage is skipped.

A typical case is presented like this:

In this case the left-hand interpretation indicates that the left lower leg (pink) is in front of the right lower leg
(blue). The right-hand interpretation indicates that the left lower leg is behind the right lower leg. For this image,
it is clear that the left leg is in front of the right leg and so the left-hand interpretation is correct. To indicate this,
simply click on the left-hand image and the software will move to the next overlap.
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2.4.6 Finishing markup

When the markup is complete a dialog box will appear that asks if you wish to move to edit mode or to continue
marking up the image.

Under normal circumstances, the user will simply move on to the edit mode. However, if you know that you
have made a mistake in the markup stages, clicking the other button gives you the opportunity to correct any
mistakes.

2.4.7 Correcting markup

It is possible at any point to go back to markup stage although with practice this is rarely necessary.

o  From the editing mode, click "markup image" from the right-hand panel (all edits to the image will be lost).
Then click on the section (select face, choose gender, mark joints, mark curves, identify overlaps) in the
left-hand panel.

o  From the markup modes, click directly on the section (select face, choose gender, mark joints, mark
curves, identify overlaps) in the left-hand panel.

Each markup mode works slightly differently when we return to it. Rather than marking the image with a series
of sequential clicks, it is possible to change any aspect of the markup at any time. The following sections
describe each stage in turn.

Select the face

You can adjust the face points by clicking and dragging the two controls on the face oval. The face oval should
roughly surround the face in the image.
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Choose gender

To select the gender, click on the picture of the male or female body in the pop-up window.

If you make a mistake, you can return to this part of the program by clicking on "Choose Gender" on the right-
hand side panel.

Mark skeleton joints

When we return to the skeleton markup stage, we can see all of the points simultaneously. To change the
position of one of the joints simply click and drag the point across the image.
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Mark curves

When we return to the curve markup stage, we still deal with the curves one body part at a time, but now we can
adjust any of the points on the curves by clicking on them and dragging.

To move between body parts, press the space bar to move to the next part or backspace to move back, or use
the number keys 1, 2, 3, 4, and 5 to directly move to the right arm, left arm, torso, right leg and left leg
respectively. You can also identify the desired body part on the curve widget on the right-hand side:

Alternatively, you can click on the colored number tags that are superimposed on the image.
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Identify overlaps

To change the interpretation, click on the list on the right-hand panel to toggle between which body part is in
front.

Moving to edit mode

When you have finished making all the changes you want, click the button in the right-hand panel
corresponding to the edit mode (e.g shape sliders or skin) that you wish to move to.

The software will then re-do its analysis and you can begin editing again.
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2.4.8 Common markup mistakes

In general, placing the curves with great precision is not necessary. As long as the skeleton points and curves
are in roughly the correct place, the editing functions will work satisfactorily.

There are however, two common pitfalls:

o When the subject faces away from the camera, make sure to mark the right arm points on the right-hand
side of the image (as opposed to the left-hand side as is normal). The software will know that the person
faces away from the camera and identify the center as 'back' rather than 'chest'.

o Be careful to identify the overlaps correctly -- if you make a mistake here, it means that some useful curves
will not be visible in the editing stages and other erroneous curves will appear.
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2.5 Editing the image

Once we have marked up the image, it is now ready to manipulate. After a short processing interval, the
software will move to the editing mode and a number of different sections appear in the right-hand panel.
These sections comprise:

o Shape sliders
o Shape tools
o Skin  
o Face
o Warp fixer
o Picture

After finishing the markup stages, the shape sliders mode will be open. A final option on the right-hand side is
to return to the markup procedure. To move to one of these sections, simple click on its name.

Each of these sections has a number of controls and two buttons that are visible in the title bar when it is open.
The first button allows you to turn the effects of this section off (shape sliders and shape tools are connected in
this regard). To reset the effects of a section, press this button (it will change from green to red) and then start
again. The second button activates the help system which explains the controls in the panel.

In addition, the main editing page contains several other controls. There is a tab above the main image that
allows you to flip between the original and edited image (it will do nothing until you make some changes).
Pressing the ENTER key achieves the same result. There is a second tab at the extreme left of the screen that
allows you to see the original image next to the edited image (clicking on it twice removes the original image
again). 
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 Finally, there is a tool bar, which contains buttons for:

o Home / Close -- close the current project and return to home screen 
o Save Project -- save the current project
o Export Image -- save the edited image 
o Share -- Post a before / after picture to Facebook
o Undo -- Undo the last change
o Redo -- Redo the last undone change
o Help -- Opens a context sensitive help that guides you around the screen
o Lock -- Locks the toolbar so that it is always visible or unlocks it so that it only appears when the mouse is

close

Home

Save

Export image
Share on Facebook

Undo

Redo

Help

Lock

2.5.1 Shape sliders

In the shape slider mode, it is possible to make large manipulations to the shape of the body by simply moving
the sliders in the right-hand panel.

The sliders are separated into several different sections.
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There are four sliders at the top of the section make large scale changes to the entire shape:

o  Slim -- makes the entire subject thinner
o  Curvy (women only) -- narrows the waist and expands the chest and hips 
o  Built (men only) -- slims the stomach and broadens the shoulders
o  Lift -- raises the bottom / chest areas
o  Tall -- extends the legs and the torso length and stretches the neck

Below these sliders, there are four sections dealing respectively with the torso, legs, arms and skeleton. Each
section can be opened to reveal more sliders by clicking on the title or triangle, and subsections can be
opened in the same way to edit progressively finer parts of the body.
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The sections comprise

o  Torso -- allows editing of the hips, waist, chest etc.
o  Arms -- allows editing of the upper and forearms, elbows, wrists etc.
o  Legs -- allows editing of the upper legs, thighs, knees, lower legs and ankles
o  Skeleton -- allows movement of the joints to achieve various effects, including lengthening the legs, tilting

the hips and extending the neck 

For further information, consult the shape sliders reference .65
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2.5.2 Shape tools

The shape tools section provides a number of tools for editing the shape of the person in the image by directly
manipulating the image. In general these tools make finer scale changes to the image than is possible with
the shape sliders.

Edit body tool

When this tool is selected, and the mouse is moved over the image, the curves on the edge of the body will be
highlighted. You can use this tool to pick up the curves and move them. The program knows about the statistics
of human body shape and so tries to find a solution that is compatible with the current mouse position but also
sensible. So, for example, if you move the left-hand side of the torso in then the right-hand side of the torso will
also move in. Once a point has been moved, it is fixed unless another point is placed nearby.

When the move curves tool is selected, it is also possible to move the skeleton joints, which are represented
as colored dots at the joint positions. To move the joints simply drag them to a new position.

Edit body local tool

The local curve tool allows you to make fine scale local changes to the curve. To move a curve, simply click on it
and move the mouse to drag it to a new position. Only curve positions very close to the mouse will be affected.
When this tool is selected, a slider will appear that controls the size of the region over which the local change is
affected.
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Drag tool

The drag tool can be used anywhere in the image -- it is used to locally change the shape of the image by
clicking and dragging the mouse. A circle surrounding the cursor allows you to visualize the area which will be
dragged. When this tool is selected, sliders appear on the right-hand panel that control both the area over
which the change is made (tool size) and the strength of the change (tool strength). 

Expand tool

The expand tool can also be used anywhere in the image and causes a local expansion within the circular
cursor region when the mouse is held down. When this tool is selected, sliders appear on the right-hand panel
that control both the size of the brush and the strength of the effect.

Contract tool

The contract tool can also be used anywhere in the image and causes a local shrinking within the circular
cursor region when the mouse is held down. When this tool is selected, sliders appear on the right-hand panel
that control both the size of the cursor and the strength of the effect.
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Repair tool

The repair tool fixes problems with the shape of the image by making the shape changes locally smooth within
the circular window. Occasionally, movement of the sliders, or use of the other shape tools will cause tears,
discontinuities, or unrealistic shape changes. Applying the repair tool by holding the mouse down over the
desired area, will gradually fix these problems. When this tool is selected, sliders appear on the right-hand
panel that control both the size of the cursor and the strength of the effect.

If the SHIFT button is held down, the repair tool switches to the revert tool. This has the effect of locally restoring
the shape of the image to its original state. As well as meaning that the shape changes are locally smooth, it
also returns objects to their original position.

Fix bulges and pinches tool

The fix bulges and pinches tool is a very specific tool for sorting out problems in the shape that are at a finer
scale than the curve tools can deal with. Typically, it would be used to reduce bulges at the hips, or creases
due to fat or a tight bikini strap. To operate the tool, move the cursor over one of the existing curves. The region
under consideration is blown up and the shape is visualized before and after the change. Pressing and holding
the mouse button causes the shape change to be made. Essentially, the local shape of the contour in the
image is estimated and warped towards the smoother (but usually more desirable) curves that were drawn in
the markup change. 
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Image before tool 

Image with tool
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Image after tool 

For more information, consult the shape tools reference .

2.5.3 Skin

The skin section allows you to manipulate the skin texture and tighten the stomach region. This only applies to
the body. To manipulate skin on the face, use the face section.

Markup canvas

When the skin section opens, a second copy of the image appears on the left of the image
that we are editing. This is in grayscale, but with a red mask superimposed to indicate the
current estimated skin region. This will determine which parts of the image are changed by
this section. 
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The automatically selected skin region is usually approximately correct. However, if it is not
correct, the topmost slider ('select skin area') increases or decreases the amount of skin
selected. To further refine the skin region, use the mark skin or remove skin tools to directly
add or subtract from the skin area in the left panel.

The remaining controls in the skin section are used to manipulate the texture of the skin. The
'smooth skin' tool smooths the selected skin area to provide an airbrushing effect. The tuck
belly slider tones the stomach region to reduce fat and increase definition. The belly button
drop down menu allows you to replace the belly button with a different choice. If the new belly
button is not in the correct position, you can change it by dragging the white control point on
the left panel.

The tool bar at the bottom, contains tools to select the skin, remove skin, smooth, remove
blemishes, restore, lighten and darken. We define the effects of each below:
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Add skin tool

When this tool is selected, and the mouse is moved over the left image, a cursor consisting of two concentric
circles appears. When you paint on the canvas, skin is selected by finding any areas in the larger circle that
match the colors in the smaller circle. A preview of the area that will be selected is updated directly. When this
tool is selected two sliders appear underneath, that control the size of the concentric circles.

Remove skin tool

This tool has the opposite effect of the add skin tool -- instead of adding to the selected skin region, it
decreases the selected skin region. As with the add skin tool, two sliders appear under the tool which control
the concentric circles in the cursor.

Smooth tool

The smooth skin tool allows you to locally smooth an area in the image. It is applied by clicking and dragging
directly on the right-hand image. The size of the area over which the effect is applied and the strength of the
effect are controlled by two sliders which appear when this tool is selected. The tool will work even on regions
which have not been selected as skin, and the region you smooth will be added to the skin mask.

Remove blemishes tool

The remove blemishes tool is used to remove spots, moles, tattoos and other local features on the skin. It
makes an estimation from the edge of the circular cursor. The size of the region and the strength of effect can
be adjusted using sliders that appears under the tool when it is selected.

Restore tool

The restore tool reverts the skin in the circular cursor back to the original state. The size of the affected region
and the strength of effect can be adjusted using sliders that appear under the tool when it is selected.

Brighten skin tool

The lighten tool locally brightens the image when the user clicks on the right-hand canvas. This could be used
to decrease shadows which might make a region look flatter. The size of the affected region and the strength of
effect can be adjusted using sliders that appear under the tool when it is selected.
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Darken skin tool

The darken tool locally decreases the intensity of the image when the user clicks on the right-hand canvas.
This could be use to increase shadows which might make a region look less flat. The size of the affected
region and the strength of effect can be adjusted using sliders that appear under the tool when it is selected.

For more information, consult the skin section reference .72
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2.5.4 Face

The face section is used to make changes to the subject's face. When you click on this section, the view will
zoom into the face region and a second canvas opens on the left-hand side. This new canvas shows the
estimated markup of the facial feature points. If the points are in the wrong place, the controls in this section
will not work properly. To change the markup, simply click and drag the points to the correct position. 

Please note that the face section is intended only for frontal faces. To indicate that the face is not frontal, click
the button that is superimposed over the left (markup) canvas and this disables the effect of the rest of the
section.

The face section consists entirely of sliders which are manipulated in the right-hand panel and make changes
to the main canvas. They broadly fall into three categories:

o  Shape sliders -- these allow you to change the overall shape of the face and also to manipulate its
components (e.g eye size).

o  Smoothing sliders -- these allow you to smooth the skin in the facial region.
o  Lighting sliders -- these allow you to relight the face so that the picture is more flattering.

Note that the companion product PortraitPro is specialized to making face changes and contains many more
controls for changing the shape and appearance of facial portrait photos.

For more information, consult the face section reference .72

http://www.portraitprofessional.com/
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2.5.5 Warp fixer

When you warp the body in an image, it will sometimes distort the background in undesirable ways: lines and
other areas may have become distorted and need fixing. The warp fixer provides an intelligent way to do this,
allowing you to create 'patches' on your original image. Parts of your image covered by the same patch always
move together.

When you enter the warp fixer, you will see:

The warp fixer section provides three tools for creating and editing patches:

o line patch -- create a patch using a line. This is a quick and effective way to corrects line that have become
distorted.

o brush patch -- create a patch using a paint brush. This can be used for fixing small areas that have
become distorted.

o patch eraser -- erase parts of a patch. You can erase parts of a patch regardless of which tool you used to
create it.

As you create a patch, it automatically groups it with any others that it touches, creating a larger patch.

Patch Controls allow you to manage the patches that you have created. You can:

o Delete selected patches.
o Group selected patches so that they move in the same way.
o Ungroup selected patches so that they can move in different ways.
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2.5.6 Picture

The Picture section tackles overall changes to the contrast, brightness and color palette of the whole image,
similar to those found in more conventional image editing tools. All of the effects are achieved by moving the
sliders in the right-hand panel directly.

The sliders consist of: 

o  black and white -- converts the image to black and white
o  sepia -- converts the image to sepia 
o  auto levels -- an intelligent transformation that tries to generally improve the image
o  contrast -- increases or decreases the contrast of the image while leaving the average brightness and

color unchanged
o  exposure -- adjusts the overall brightness of the image
o  temperature -- adjusts the color of the whole image to remove any temperature (red-blue) color cast
o  tint -- adjusts the color of the whole image to remove any tints (green-purple) color cast
o  vibrance -- makes the colors in the picture more intense 
o  saturation -- similar to vibrance, but has less effect on colors that are less intense
o  recover exposure -- recovers over-exposed areas
o  fill light -- fills in shadows
o  blacks -- darkens black regions in the image

For more detail, see Picture tools .

2.6 Group Shots

Working with group shots

If there is more than one person in your image, you will need to save the image and re-open it to start working
on another body in the image.
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3 Reference

This section provides information about the different menu commands and controls in PortraitPro Body.

The Homepage Reference  page describes the application home page.

The Menu Commands  page describes each menu command.

The Marking Up the Body  page describes each of the controls available when you markup an image .

The Enhancing the Body  page describes the controls that are available when you enhance an image. 

3.1 Homepage

When you load the program or close a project, the home page will be shown.

From the homepage, you can:

o Edit a new image
o Load an existing project
o Re-load a recently-used project
o Open a tutorial concerning a particular aspect of the software

Projects

To load a new image, click the new image button. To load an existing project, click the open project button. You
can open a window that do either job by pressing the space bar while on the home page. Alternatively (and
from any point in this software), you can press CTRL+O or use Open from the File menu.

All of these actions bring up open file dialogs. In this window, you can choose the project or image that you
wish to open. 
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Recent files 

Below the open file button are icons representing the eight most recently used projects. In each case a
thumbnail of the body that was manipulated and the file name are provided. Click on the appropriate icon to
resume working on this project. This section will only appear after you have saved your first project file.

Getting started

The Getting Started section contains the overview video (which is run the first time that you load the software)
and four other tutorials, each of which consists of a short video and a project to work on. The user is
encouraged to work their way through these tutorials when they first open the software.

Learn more

The Learn More section contains a number of further tutorials that help explain other parts of the software. This
section opens up after the getting started tutorials have been run.

Scaling slider

The slider in the top right-hand of the homepage allows the user to rescale all of the elements of the user
interface. Move this slide to make everything smaller or larger so that it suits the screen that you are working on.
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3.2 Menu Commands

These are the commands available on the menu bar in PortraitPro Body. 

File
Menu

Commands to open and save files, print, or change settings

Edit
Menu

Undo & Redo

View
Menu

Commands to control the visibility and appearance of various elements of the user interface

Help
Menu

Commands to launch help, check for updates, get support, or view about box

3.2.1 File Menu

The File menu contains the following commands:

Open... Opens either an image or a project file (see Supported File Types ).

If a file is already open with unsaved changes, you will be prompted to save
or discard the changes before the new file is opened.

Save Project Saves the project in the native ('.prb') format. If the project has not previously
been saved, the File Save panel will be shown prompting you for a
filename.

This command is only available at the enhancing the body stage .

Save Project As... Saves the current file. This is similar to the Save command, except that a
File Save panel is always shown to let you select where to save the file.

This command is only available at the enhancing the body stage .

Export Image... Saves the current file. The first time this command is used after opening a
file, the following rules apply:
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If you opened a JPEG file, the enhanced image will be saved as a JPEG.

If you opened a PNG file, the enhanced image will be saved as a PNG.

If you opened a TIFF file or any RAW file type (Studio edition only), the
enhanced image will be saved as a TIFF.

All other file types can be saved as JPEG, TIFF or PNG, and can be
selected from the file types. 

From then on, this command will save the same type of file as previously
saved.

This command is only available at the enhancing the body stage .

Share Connects to Facebook and posts a before / after photo with a comment.

This command is only available at the enhancing the body stage .

Close / Homepage Closes the current session. If there are any unsaved changes, you will be
prompted to save or discard these.

The Close command returns you to the Homepage .

Print... Brings up the Print dialog that lets you print out the enhanced image.

Exit Closes the application. If there are any unsaved changes, you will be
prompted to save or discard these.

Plug-in Mode

If the application is in plug-in mode , then the only command in the File menu is Return From Plug-in, which
returns the enhanced image to the calling application and closes PortraitPro Body.

3.2.2 Edit Menu

The Edit menu contains the following commands:

Undo Provides undo for changes to slider values and changes made with the brush tools.

This means it is safe to experiment with different saved settings, or try moving any
sliders, since you can always go back to the result you had earlier if you don't like the
changes.

This command is only available at the enhance image stage.

Redo Lets you redo an operation that has been undone with the Undo command.
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3.2.3 View Menu

The View menu contains the following commands:

Full Screen Makes the application fill the entire screen, to maximize the working area.

To restore the application to its windowed state, select this command again.

Lock Toolbar Toggles whether the toolbar is always visible (locked) or only appears when the
mouse is close to the top left of the image.

Before and After Toggles whether we are viewing a single canvas (after) or two canvases side by
side (before and after).

Markup Help Toggles whether help is shown in markup mode.

Scale Change the size of the fonts and interface elements to make the elements larger
or smaller.

Animate Starts an animation showing how the image has changed (click on the canvas to
stop).

3.2.4 Help Menu

The Help menu contains the following commands:

Contents Launches the online help, showing the Table of Contents.

Quick Start Guide Launches the online help showing the Quick Start Guide .

Keyboard Shortcuts Launches the online help showing the Keyboard Shortcuts .

Check For Updates... Launches the default web browser to show whether you have the latest
version of PortraitPro Body.

If updates are available, links will be provided for you to download them.

Support... Launches the default web browser to show the PortraitPro Body support
pages.

You can use this to find answers to common questions, or to contact the
PortraitPro Body support team.

About Brings up the About Box, which shows the version of PortraitPro Body that you
have.

7
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3.3 Marking Up the Body

After loading in a new image, there are a series of markup stages that must be carried out by the user before
the image can be edited.

These are:

o  Identifying the person that we wish to edit
o  Identifying the gender of the person that we have chosen
o  Marking the positions of the person's joints in the image
o  Marking the curves on the edge of the limbs and torso
o  Identifying the depth order of the limbs (if ambiguous)

Markup Help
Throughout the markup stages, a help window is available to provide guidance. By default this is visible and is
on the left-hand side of the main canvas. A tab on the extreme left of the image (which expands when the
mouse is near) can be used to toggle the presence or absence of this markup help window. This can also be
done by choosing Markup Help from the View menu.

The help typically consists of several pages. The top-most page (visible by default) gives general instructions
for markup of this area. The other pages deal with special cases (e.g. how to make-up the skeleton when it is
partially outside the bounds of the image). To view these other pages, click on the relevant tab on the help
window. During the markup tutorials, this help will be specific to the image that you are marking up.

3.3.1 Select Face reference

To identify the person that you want to edit, move the mouse over the center of the tip of their nose. If the face is
identified successfully by the software you will now be asked to identify the gender.
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Occasionally, the software will fail to identify the face based on your click. This often happens when the face is
close to profile or is partially obscured by hair or another object. When this happens, the software will prompt
you to select a second point on the chin of the person you wish to edit. As you do this, an oval will be displayed
and when you have the correct chin point, this oval should roughly surround the face.

Alternatively, the face may not have been detected because you clicked on the wrong image position in the first
stage. If this is the case, you can undo your change by selecting Undo from the Edit menu or using the shortcut 
CTRL + Z.
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Special cases:

Face turned away If the face is turned away, then make your best guess as to where the nose
would be.

Nose hidden If the nose is hidden by another object then guess where it would be.

Nose out of image If the nose is out of the image then click where you guess it would be. You can
pan the image using CTRL + mouse drag or via the navigator in the top right
corner.
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3.3.2 Mark skeleton joints reference

During the initial markup process, the joints are marked one after another, in a predetermined order. To mark a
joint position, simply click on the appropriate point in the image. The cursor will then jump to the next point.

If you want to go back and change the position of the point you just marked, you can go back to the previous
point by pressing backspace or right clicking.

When the user returns to this section (by clicking on Mark Joints in the right-hand panel), the existing joint
positions are all shown in parallel and the user can adjust them by clicking and dragging.

The skeleton joints are (in order of marking) 

Right shoulder A point in the center of the right shoulder joint, so that it is mid-way between the two
sides of the arm. The right shoulder would be on the left of the image for photos
where the subject faces the camera (i.e. for most photos).

Right elbow A point in the center of the right elbow so that it is mid-way between the upper and
lower arm and mid-way between the two sides of the upper arm and the two sides
of the lower arm.
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Right wrist A point in the center of the right wrist, so that it is mid-way between the two sides of
the arm.

Left shoulder A point in the center of the left shoulder joint, so that it is mid-way between the two
sides of the arm. The left shoulder would be on the right of the image for photos
where the subject faces the camera.

Left elbow A point in the center of the left elbow so that it is mid-way between the upper and
lower arm and mid-way between the two sides of the upper arm and the two sides
of the lower arm.

Left wrist A point in the center of the left wrist, so that it is mid-way between the two sides of
the arm.

Belly button A point on the belly button of the subject.

Right hip A point at the top of the right leg, mid-way between the two sides of the leg.

Right knee A point in the center of the right knee so that it is mid-way between the upper and
lower leg and mid-way between the two sides of the upper leg and the two sides of
the lower leg.

Right ankle A point in the center of the right ankle that is mid way between the two contours of
the lower leg.

Left hip A point at the top of the left leg, mid-way between the two sides of the leg.

Left knee A point in the center of the left knee so that it is mid-way between the upper and
lower leg and mid-way between the two sides of the upper leg and the two sides of
the lower leg.

Left ankle A point in the center of the left ankle that is mid way between the two contours of the
lower leg.

Special cases:

Body faces away If the body faces away then the right shoulder will be on screen right. Otherwise it
will be on screen left.

Limb obscured If the limb is hidden by another part of the body or object, then guess where is
should appear. Press 'h' or use the control in the right-hand panel to tag it as
hidden (see below).

Baggy clothes If the limb is obscured by baggy clothing make your best guess as to where it would
be.

Limb out of image If the joint is partially or entirely outside the image, guess where it would be.
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Panning the canvas

When the mouse is close to the edge of the image, an arrow will appear which indicates that you can pan the
canvas in that direction by pressing the space bar.

Hidden limbs

The widget on the right-hand panel can be used to mark limbs as hidden. For example, if the arm is completely
obscured by the body or by another object, it could be identified as hidden here. 

When a limb is marked as hidden, it will appear as dashed in the main panel. An alternative method for
toggling between the limb preceding the current joint being hidden and visible, is to press the 'h' key while the
mouse is in the main panel.

Marking a limb as hidden means that it will have no further effect on the proceedings and means that there is
no need to mark the curves of this limb in the next stage. Limbs should only be marked as hidden if they are
completely invisible in the image. If any part is visible (e.g. the top half of the upper leg is in the image, but the
lower half is cut off), then they should not be tagged as hidden.
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3.3.3 Mark curves reference

The fourth stage of markup is to mark the curves of the body. This proceeds in the fixed order:

o  right arm
o  left arm
o  torso 
o  right leg
o  left leg

During the initial markup of the image, the curve is attached to the mouse cursor. Mark the first point by moving
the mouse cursor to a position on the edge of the limb. The mouse cursor is constrained to stay within a small
rectangle or triangle, so it should be clear which edge should be marked. The goal is to place this particular
point on the edge of the limb. Don't worry about whether the entire curve lines up well at this stage -- this will
happen naturally as you mark more points.

To fix the point, press the mouse button. The program will then fix that point and jump to the next position on the
curve. When you have marked all of the points on the right arm, the software will scroll to the left arm and the
process continues. Points that are on hidden limbs or outside the image are skipped automatically.

If you want to go back and change the position of the point you just marked, you can go back to the previous
point by pressing backspace or right clicking.

When the user returns to edit curves that have already been marked up, all of the fixed points on a given part of
the body are visible simultaneously. These points (and therefore by proxy the curves to which they are attached)
can be moved by clicking and dragging them. It is possible to switch between curve sets by using the left and
right arrow keys, clicking on the numbers in the image, or by clicking on the control in the right-hand panel.
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Female Torsos

For the female torso, the curves should be marked around the breasts.

     

Special cases

Limb obscured If the limb is hidden by another part of the body or object, then guess where the
curves would be if they were not obscured.

Baggy clothes If the limb is obscured by baggy clothing, then make your best guess as to where
the body curves would be.
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3.3.4 Identify overlaps reference

For some images, the marked bones and curves overlap one another and the software will quiz you to identify
which limb is in front of which. For other images, where there is no ambiguity then this stage is skipped.

A typical case is presented like this:

In this case the left-hand interpretation indicates that the left lower leg (pink) is in front of the right lower leg
(blue). The right-hand interpretation indicates that the left lower leg is behind the right lower leg. For this image,
it is clear that the left leg is in front of the right leg and so the left-hand interpretation is correct. To indicate this,
simply click on the left-hand image and the software will move to the next overlap.

When the image has already been marked up but the user wants to edit the overlaps the user is presented only
with the current interpretation for a particular ambiguity. To change the interpretation click on the image to
toggle which body part is in front. To change which overlaps we are considering, select the comparison from
the right-hand panel.
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3.4 Editing the Image

This section describes the main controls available when you are editing an image.

Canvases

Enhanced Photo - Shows the enhanced ("After") image.

Original Photo - Shows the original ("Before") image (not always present). 

To pan either canvas, hold CTRL and drag the canvas with the mouse. To zoom in and out, use the + and -
keys. 

Alternatively you can use the navigator panel.

Viewing the enhanced image

The tab to the left of the images controls the layout of the working view.

Click on the Side by Side tab to return to the side by side layout.

Click on the Hide Original tab to have only the enhanced image shown.

Flipping between the enhanced and original image

Whichever layout you have, you can press the Enter key at any time to switch from the enhanced image view to
show the original image. The original image is only shown while you hold down the Enter key.
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This lets you flip between the enhanced and original image which is a great way to see the changes.

Alternatively, you can click and hold the mouse button down on the tab above the images that says Flip To
Original. If you Shift-Click this tab, the system will smoothly animate between the original and enhanced
images.

Toolbar

The toolbar contains buttons for:

o  Home / Close -- close the current project and return to home screen 
o  Save Project -- save the current project
o  Export Image -- save the edited image 
o  Share -- Post a before / after picture to Facebook
o  Undo -- Undo the last change
o  Redo -- Redo the last undone change
o  Help -- Opens a context sensitive help that guides you around the screen

Navigator

The navigator in the top-right corner helps you move around the canvas. It provides controls for zooming to fit
the image, zooming into the body, and zooming to the face of the current subject as well as controls for panning
and zooming. More details can be found in the navigator reference .

Markup

Clicking on the markup header returns to the markup section so that you can edit the body markup if you made
a mistake. Note that all of your edits to the image will be lost if you choose this option.

Edit Sections

These are grouped into the following sections:

Shape Sliders -- make large scale changes to the shape of the body by dragging sliders

Shape Tools -- make finer scale changes to the body shape using brushes and tools

Skin -- make changes to the skin texture and appearance

Face -- make changes to the shape and appearance of the face

Picture -- make global changes to aspects of the image such as brightness and contrast
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3.4.1 Navigator

The navigator is in the top right corner of the markup and editing screens.

It lets you see what part of the whole image is visible in the working view. It also provides controls to let you
zoom in and out, or pan the current view.

The Navigator contains the following controls:

Header bar Lets you collapse the navigator to create extra space.

Click again to expand the Zoom control.

Help button The help button triggers the context sensitive help system which helps explain the
controls in this section.

Zoom Slider Lets you zoom in (slide to the right) or out (slide to the left).

"Fit to picture" Button Zooms the view so that the whole image is visible. 

"Fit to body" Button Zooms the view so that the view is centered on the current body. 

"Fit to face" Button Zooms the view to the face. 

The rectangle in the Zoom Control can be dragged to pan the view.
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Keyboard Shortcuts

+ Zoom in

- Zoom out

1 Zoom so that whole image is visible

2 Zoom so that body is visible

3 Zoom so that the face is visible

You can also pan the image by holding down CTRL and dragging the canvas with the mouse.

3.4.2 Shape sliders

The shape sliders allow you to make large changes to the shape of the subject.

The shape sliders section contains the following controls:

Header bar Lets you collapse the shape slider section.
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Click again to expand the shape sliders control.

On/Off button Lets you turn the shape changes on or off.

To reset the shape changes, use this button to turn them off and then
make new changes by moving the sliders.

This button also turns on or off the shape tools section.

Help button The help button triggers the help system which helps explain the
controls in this section.

Sliders Each slider allows you to change the shape in a different way.

To move the slider, click on the handle and drag to the left or right.

To reset the slider, double click on it.

If a slider will have no effect then it will be grayed out and showed as
inactive.

The parts of the image affected by the slider can be previewed by clicking
on its name.

Expand sliders button Opens up a new section or subsection of sliders.

Collapse sliders button Collapse a section or subsection of sliders.

Master Sliders

slim Makes the body slimmer overall 

curvy (women only) Makes the waist smaller and the hips and chest larger

built (men only) Widens the shoulders and narrows the waist

lift Lifts the chest, abdomen and bottom 

tall Lengthens the limbs and torso

Torso Sliders

master changes the size of the entire torso

chest changes the size of the chest

waist changes the size of the waist
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hips changes the width of the hips

abdomen changes the size of the abdomen (same as waist slider if frontal view)

bottom changes the size of the bottom (same as hips if frontal view)

chest height Lifts the chest vertically

abdomen height Lifts the abdomen vertically 

bottom height Lifts the bottom vertically

Arm Sliders

master Changes the size of both arms

left Changes the size of the left arm

left upper Changes the size of the upper left arm

left lift Lifts the region bellow the upper left arm

left lower Changes the size of the lower left arm

left wrist Changes the size of the left wrist

right Changes the size of the right arm

right upper Changes the size of the upper right arm

right lift Lifts the region below the upper right arm

right lower Changes the size of the lower right arm

right wrist Changes the size of the right wrist

Leg Sliders

master Changes the size of both legs

left Changes the size of the left leg
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left upper Changes the size of the left upper leg

left thigh Changes the size of the upper part of the left upper leg

left knee Changes the size of the left knee

left lower Changes the size of the left lower leg

left ankle Changes the size of the left ankle

right Changes the size of the right leg

right upper Changes the size of the right upper leg

right thigh Changes the size of the upper part of the right upper leg

right knee Changes the size of the right knee

right lower Changes the size of the right lower leg

right ankle Changes the size of the right ankle

Skeleton Sliders

neck length Moves the head parallel to the torso

face position Moves the head perpendicular to the torso

shoulder width Widens the shoulders

left elbow Moves the left elbow towards or away from the body (sometimes useful
when slimming the torso to avoid a tear in the image)

right elbow Moves the right elbow towards or away from the body (sometimes useful
when slimming the torso to avoid a tear in the image)

hips angle Changes the angle of the hips

torso length Changes the length of the torso

hip height Moves the hips up or down, and hence changes the ratio of the torso
length to leg length

leg length Increases the length of the legs
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3.4.3 Shape tools

The shape tools section provides a number of tools for editing the shape of the person in the image by directly
manipulating the image. In general these tools make finer scale changes to the image than is possible with
the shape sliders.

The shape tools section contains the following controls:

Header bar Allows you to collapse the shape tools section.

Click again to expand the shape tools section.

On/Off button Allows you to turn the shape changes on or off.

To reset the shape changes, use this button to turn them off and then make new
changes by using the tools.

This also turns on or off the shape slider section.

Help button The help button triggers the context sensitive help system which helps explain the
controls in this section.

Tools Each tool makes different types of changes to the body.

Click on the slider icon to select it.

Press the TAB button repeatedly to cycle through the tools.

Current tool The current tool is highlighted and the name is shown below the tool icons.

A brief description of the tool is also shown.

Tool sliders For some tools, sliders will appear under the tool icons that control the size and
strength of the tool.

To reset the sliders, double click on them.
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Keyboard Shortcuts

[ Decrease tool size (where applicable)

] Increase tool size (where applicable)

9 Decrease tool strength (where applicable)

0 Increase tool strength (where applicable)

Tab Moves to next tool

Shift When held switches to alternate tool -- edit body to edit body local and vice-versa,
expand to contract and vice-versa, repeat to revert.

Edit body tool

When this tool is selected, and the mouse is moved over the image, the curves on the edge of the body and will
be highlighted. You can use this tool to pick up the curves and move them. The program knows about the
statistics of human body shape and so tries to find a solution that is compatible with the current mouse
position but also sensible. So, for example, if you move the left-hand side of the torso in then the right-hand
side of the torso will also move in. Once a point has been moved, it is fixed unless another point is placed
nearby.

When the move curves tool is selected, it is also possible to move the skeleton joints, which are represented
as colored dots at the joint positions. To move the joints simply drag them to a new position.

Edit body local tool

The local curve tool allows you to make fine scale local changes to the curve. To move a curve, simply click on it
and move the mouse to drag it to a new position. Only curve positions very close to the mouse will be affected.
When this tool is selected, a slider will appear that controls the size of the region over which the local change is
affected.

Drag tool

The drag tool can be used anywhere in the image -- it is used to locally deform the shape of the image by
clicking and dragging the mouse. A circle surrounding the cursor allows you to visualize the area which will be
dragged. When this tool is selected, sliders appear on the right-hand panel that control both the area over
which the change is made and the strength of the change.

Expand tool

The expand tool can also be used anywhere in the image and causes a local expansion or dilation within the
circular cursor region when the mouse is held down. When this tool is selected, sliders appear on the right-
hand panel that control both the size of the cursor and the strength of the effect.
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Contract tool

The contract tool can also be used anywhere in the image and causes a local contraction or shrinking within
the circular cursor region when the mouse is held down. When this tool is selected, sliders appear on the right-
hand panel that control both the size of the cursor and the strength of the effect.

Repair / revert tools

The repair tool fixes problems with the shape of the image by making the shape changes locally smooth within
the circular window. Occasionally, movement of the sliders, or use of the other shape tools will cause tears,
discontinuities, or unrealistic shape changes. Applying the repair tool by holding the mouse down over the
desired area, will gradually fix these problems. When this tool is selected, sliders appear on the right-hand
panel that control both the size of the cursor and the strength of the effect.

If the SHIFT button is held down, the repair tool switches to the revert tool. This has the effect of locally restoring
the shape of the image to its original state. As well as meaning that the shape changes are locally smooth, it
also returns objects to their original position.

Fix bulges / pinches tool

The fix bulges / pinches tool is a very specific tool for sorting out problems in the shape that are at a finer scale
than the curve tools can deal with. Typically, it would be used to reduce bulges at the hips, or creases due to fat
or a tight bikini strap. To operate the tool, move the cursor over one of the existing curves. The region under
consideration is blown up and the shape is visualized before and after the change. Pressing and holding the
mouse button causes the shape change to be made. Essentially, the local shape of the contour in the image is
estimated and warped towards the smoother (but usually more desirable) curves that were drawn in the
markup change.

3.4.4 Skin tools

The skin tools section provides a number of tools for editing the skin of the person in the image and tighten the
stomach region by either moving sliders, or by directly manipulating the image. This only applies to the body --
to manipulate skin on the face, use the face section.

The skin section allows you to manipulate the skin texture and tighten the stomach region. This only applies to
the body -- to manipulate skin on the face, use the face section.
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Markup canvas

The skin section contains the following controls:

Header bar Click to select the skin section.

Lets you collapse the skin section.

Click again to expand the skin section.

On/Off button Lets you turn the skin changes on or off.

To reset the skin changes, use this button to turn them off and then make new
changes by using the controls.

This also turns on or off the skin slider section.

Help button The help button triggers the context sensitive help system which helps explain the
controls in this section.

Select skin area Moving this slider increases or decreases the amount of skin selected on the
markup canvas.

Smooth skin This slider smooths the region of skin selected on the markup canvas.

Tummy Tuck This slider replaces the stomach region with a more toned version.

Belly Button The Belly Button drop down menu allows the replacement of the current Belly Button
with various different options. The position of the new Belly Button can be
manipulated by a control on the markup canvas.
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Skin Tools

Below the skin sliders are a set of tools for selecting and editing the skin.

Tools Each tool makes different types of changes to the skin.

Click on the slider icon to select it.

Press the TAB button repeatedly to cycle through the tools.

Current tool The current tool is highlighted and the name is shown below the tool icons.

A brief description of the tool is also shown.

Tool sliders For some tools, sliders will appear under the tool icons that control the size and
strength of the tool.

To reset the sliders, double click on them.

The tools are as follows:

add skin When this tool is selected, and the mouse is moved over the left image, a cursor
consisting of two concentric circles appears. When you paint on the canvas, skin is
selected by finding any areas in the larger circle that match the colors in the smaller
circle. A preview of the area that will be selected is updated directly. When this tool
is selected two sliders appear underneath, that control the size of the concentric
circles. Holding shift while this tool is selected switches to the remove skin tool.

remove skin This tool has the opposite effect of the add skin tool -- instead of adding to the
selected skin region, it decreases the selected skin region. As with the add skin
tool, two sliders appear under the tool which control the concentric circles in the
cursor. Holding shift while this tool is selected switches to the add skin tool.

smooth skin The smooth skin tool allows you to locally smooth an area in the image. It is
applied by clicking and dragging directly on the right-hand image. The size of the
area over which the effect is applied and the strength of the effect are controlled by
two sliders which appear when this tool is selected. The tool will work even on
regions which have not been selected as skin, and the region you smooth will be
added to the skin mask.

remove blemishes The remove blemishes tool is used to remove spots, moles, tattoos and other local
features on the skin. It makes an estimation from the edge of the circular cursor.
The size of the region and the strength of effect can be adjusted using sliders that
appears under the tool when it is selected.

restore The restore tool reverts the skin in the circular cursor back to the original state. The
size of the affected region and the strength of effect can be adjusted using sliders
that appear under the tool when it is selected.

brighten skin The lighten tool locally brightens the image when the user clicks on the right-hand
canvas. This could be used to decrease shadows which might make a region look
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flatter. The size of the affected region and the strength of effect can be adjusted
using sliders that appear under the tool when it is selected.

darken skin The darken tool locally darkens the image when the user clicks on the right-hand
canvas. The size of the affected region and the strength of effect can be adjusted
using sliders that appear under the tool when it is selected.

Keyboard Shortcuts
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[ Decrease tool size (where applicable)

] Increase tool size (where applicable)

9 Decrease tool strength (where applicable)

0 Increase tool strength (where applicable)

Tab Moves to next tool

Shift When held switches to alternate tool -- edit skin to remove skin and vice-versa,
brighten to darken and vice-versa

3.4.5 Face tools

The face section is used to make changes to the subject's face. When you click on this section, the view will
zoom into the face region and a second markup canvas opens on the left-hand side. 

Markup canvas

The skin section contains the following controls:

Header bar Click the face section.

Lets you collapse the face section.

Click again to expand the face section.
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On/Off button Lets you turn the face changes on or off.

To reset the face changes, use this button to turn them off and then make
new changes using the controls to begin again.

Help button The help button triggers the context sensitive help system which helps
explain the controls in this section.

Sliders Each slider allows you to change the face in a different way.

To move the slider, click on the handle and drag to the left or right.

To reset the slider, double click on it.

Expand sliders button Opens up a new section or subsection of sliders.

Collapse sliders button Collapse a section or subsection of sliders.
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Controls

Shape This slider makes overall changes to the shape of the face.

Jaw This slider makes changes to the jaw shape.

Forehead This slider makes changes to the forehead shape.

Widen eyes The widen eyes slider increases the size of the eyes.

Smile The smile slider makes small changes at the corners of the mouth to
increase the degree to which the person is smiling.

Smooth Skin The smooth skin slider smooths the skin over the entire face.

Around Eyes This slider smooths the skin around the eyes of the subject to remove bags
and wrinkles.

Lighting Contrast The lighting contrast slider changes the lighting contrast.

Modeling Light Relights in a way that makes the subject more attractive.

Smokey Eyes Subtle smokey eyes.

Note that the companion product PortraitPro is specialized to making face changes and contains many more
controls for changing the shape and appearance of facial portrait photos.

http://www.portraitprofessional.com/
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3.4.6 Picture tools

These controls affect the whole image and allow you to adjust the overall look of the picture, controlling things
like the contrast and color temperature.

The picture section contains the following controls:

Header bar Click the picture section.

Lets you collapse the picture section.

Click again to expand the picture section.

On/Off button Lets you turn the picture changes on or off.

To reset the picture changes, use this button to turn them off and then make new
changes using the controls to begin again.

Help button The help button triggers the context sensitive help system which helps explain the
controls in this section.

Sliders Each slider allows you to change the picture in a different way.

To move the slider, click on the handle and drag to the left or right.

To reset the slider, double click on it.

Sliders

Black and White Takes the picture from color to Black and White and anywhere in between.

Sepia Takes the picture from color to Sepia and anywhere in between.
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Auto Levels Automatically sets the levels so that the darkest thing in the picture is black and the
brightest thing is white.

Contrast Increases or decreases the contrast of the whole image in such a way so as to bring
out the detail but leave the average brightness and color of the image unchanged.

Exposure Adjusts the overall exposure (brightness) of the whole image.

Temperature Adjusts the color of the whole image to remove any temperature (red-blue) color
cast.

Tint Adjusts the color of the whole image to remove any tint (green-purple) color cast.

Vibrance Adjusts the overall vibrance of the whole image. Increasing the vibrance will make
the colors in the picture more intense. Decreasing the vibrance will make the colors
less intense (more gray).

Saturation Adjusts the overall color saturation (color intensity) of the whole image. Vibrance and
Saturation are similar effects, the difference is that vibrance has less effect than
saturation on colors that are less intense. Neither slider affects areas that are black,
white or gray.

Recover exposure If part of a picture is very over exposed, it will recover some of the detail in the over
exposed areas.

Fill light Fills the shadows with light.

Blacks Makes the blacks blacker.
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Example
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3.5 Plug-in Installation Guide

Studio Edition Only

Installing the PortraitPro Body Photoshop Plug-in

In the Studio editions of PortraitPro Body, you have the option to use PortraitPro Body as a plug-in  from
Photoshop and other compatible photo editing suites.

This option is available to install on the Installation Complete screen of the Studio editions.

To begin the plug-in installation, click Finish on the Installation Complete screen with the Launch Photoshop
Plug-in Installer check-box checked.

The installer will be signed by Anthropics Technology Ltd. Select Continue to progress to the installer.

The language select screen will appear. Select your language and click OK to continue.

The Welcome Screen will appear, click Next > to move onto the next screen.

The Select Install Location screen lets you select the programs you want the plug-in to be installed into. The
installer will automatically detect installed software that is compatible with the plug-in and display it. Check the
detected software boxes to install the plug-in for that program. You can also manually select the installation
path by checking the Choose Install Path Manually box, which will allow you to install the plug-in to a specific
folder. Once you have selected the options you require, click Next > to progress to the next screen.

If you selected Choose Install Path Manually in the Select Install Location screen, you will be taken to the
Plug-in Destination Folder screen. You will be able to select the folder of any supported program that the plug-
in has not automatically detected. Click Browse and select the plug-in folder of the program that you would like
the PortraitPro plug-in installed to. Then click Next >.

On this screen you are prompted to select the version of the plug-in you want to be installed. The version
should match the program you are installing the plug-in into. For 32-bit applications, select the 32-bit plug-in
and the 64-bit plug-in for 64-bit applications. When you have made your selection, click Next >.

Clicking Install on this screen will install the PortraitPro Body plug-in into the chosen programs.

If you install Photoshop after PortraitPro Body and wish to add the Plug-in, you can run the Photoshop Plug-in
Installer for PortraitPro Body, which will be either directly available from the Start Menu, or can be found by
choosing Windows Q and searching for it. Alternatively, you can manually run the executable which is usually
found at C:\Program Files\PortraitProBody\PhotoshopPluginInstaller.exe.

Re-installing plug-ins

If you did not install the plug-ins when PortraitPro Body was installed, perhaps because you did not have the
other application already installed at that time, you can install the plug-in later.

To do this, run the installer for PortraitPro Body again.

Troubleshooting

If the PortraitPro Body plug-in does not appear in Photoshop (or other compatible application), it may not have
installed correctly. This can be caused by the plug-in being installed into the wrong folder.

To fix this, you need to find the correct folder for the plug-in to be installed into. Usually, the plug-in install
location is "C:\Program Files\<APPLICATION-NAME>\Plug-ins" for example, "C:\Program Files\Adobe
Photoshop CS5\Plug-ins\". 

17
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3.6 Third Party Credits

PortraitPro Body uses a number of third-party libraries, which are acknowledged here. We offer our thanks to
the authors for providing these valuable resources.

dcraw

RAW image reading is provided by dcraw.

Copyright 1997-2012 by Dave Coffin, dcoffin a cybercom o net

tifflib

TIFF image reading and writing is provided by libtiff.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its
documentation for any purpose is hereby granted without fee, provided that (i) the
above copyright notices and this permission notice appear in all copies of the
software and related documentation, and (ii) the names of Sam Leffler and Silicon
Graphics may not be used in any advertising or publicity relating to the software
without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY
OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE
USE OR PERFORMANCE OF THIS SOFTWARE.

jpeglib

JPEG image reading and writing is provided by jpegtiff.

This software is based in part on the work of the Independent JPEG Group.

This software is copyright (C) 1991-2011, Thomas G. Lane, Guido Vollbeding.

pnglib

PNG image reading and writing is provided by pnglib.

zlib

Zlib compression support is provided by zlib.

(C) 1995-2012 Jean-loup Gailly and Mark Adler

Adobe DNG SDK

DNG reading is provided by the Adobe DNG SDK.

http://www.cybercom.net/~dcoffin/dcraw/
http://www.libtiff.org/
http://www.ijg.org/
http://www.libpng.org/pub/png/libpng.html
http://www.zlib.net/
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Lossless JPEG code adapted from:

Copyright (C) 1991, 1992, Thomas G. Lane.
Part of the Independent JPEG Group's software.

Copyright (c) 1993 Brian C. Smith, 
The Regents of the University of California
All rights reserved.

Copyright (c) 1994 Kongji Huang and Brian C. Smith. 
Cornell University
All rights reserved.

Permission to use, copy, modify, and distribute this software and its documentation
for any purpose, without fee, and without written agreement is hereby granted,
provided that the above copyright notice and the following two paragraphs appear in
all copies of this software.

IN NO EVENT SHALL CORNELL UNIVERSITY BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE
AND ITS DOCUMENTATION, EVEN IF CORNELL UNIVERSITY HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. 

CORNELL UNIVERSITY SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
THE SOFTWARE PROVIDED HEREUNDER IS ON AN "AS IS" BASIS, AND CORNELL UNIVERSITY HAS NO
OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.

Copyright © 2006 Adobe Systems Incorporated. All rights reserved.

Adobe is a registered trademark or trademark of Adobe Systems Incorporated in the
United States and/or other countries. Windows is either a registered trademark or a
trademark of Microsoft Corporation in The United States and/or other countries. Mac is
a trademark of Apple Computer, Inc., registered in the United States and other
countries. All trademarks noted herein are the property of their respective owners.

Adobe XMP SDK

The Adobe XMP SDK is used by the Adobe DNG SDK

Copyright 2009 Adobe Systems Incorporated and others.  All rights reserved.  The
original version of this source code may be found at http://adobe.com.

lcms library

ICC color profile handling is provided by lcms.

Little CMS

Copyright (c) 1998-2007 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the "Software"), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies
or substantial portions of the Software.

http://adobe.com
http://www.littlecms.com/
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

OpenCV

Automatic feature finding makes use of the OpenCV library.

                          License Agreement

               For Open Source Computer Vision Library

Copyright (C) 2000-2008, Intel Corporation, all rights reserved.

Copyright (C) 2008-2011, Willow Garage Inc., all rights reserved.

Third party copyrights are property of their respective owners.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

  * Redistributions of source code must retain the above copyright notice, this list
of conditions and the following disclaimer.

  * Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

  * The name of the copyright holders may not be used to endorse or promote products
derived from this software without specific prior written permission.

This software is provided by the copyright holders and contributors "as is" and any
express or implied warranties, including, but not limited to, the implied warranties
of merchantability and fitness for a particular purpose are disclaimed. In no event
shall the Intel Corporation or contributors be liable for any direct, indirect,
incidental, special, exemplary, or consequential damages (including, but not limited
to, procurement of substitute goods or services; loss of use, data, or profits; or
business interruption) however caused and on any theory of liability, whether in
contract, strict liability, or tort (including negligence or otherwise) arising in any
way out of the use of this software, even if advised of the possibility of such
damage.

Machine Learning Framework

A machine learning framework is provided by Darwin.

DARWIN: A FRAMEWORK FOR MACHINE LEARNING RESEARCH AND DEVELOPMENT

Copyright (c) 2007-2012, Stephen Gould

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice, this list
of conditions and the following disclaimer.

http://opencv.willowgarage.com
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    * Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

    * Neither the name of the software's copyright holders nor the names of its
contributors may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Boost

General classes are provided by boost.

Boost Software License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization obtaining
a copy of the software and accompanying documentation covered by this license (the
"Software") to use, reproduce, display, distribute, execute, and transmit the
Software, and to prepare derivative works of the Software, and to permit third-parties
to whom the Software is furnished to do so, all subject to the following:

The copyright notices in the Software and this entire statement, including the above
license grant, this restriction and the following disclaimer, must be included in all
copies of the Software, in whole or in part, and all derivative works of the Software,
unless such copies or derivative works are solely in the form of machine-executable
object code generated by a source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT
HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER
LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Delaunay Triangulation

A Delaunay triangulation function is provided by Ken Clarkson, AT&T.

Ken Clarkson wrote this.  Copyright (c) 1995 by AT&T.

Permission to use, copy, modify, and distribute this software for any purpose without
fee is hereby granted, provided that this entire notice is included in all copies of
any software which is or includes a copy or modification of this software and in all
copies of the supporting documentation for such software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.  IN
PARTICULAR, NEITHER THE AUTHORS NOR AT&T MAKE ANY REPRESENTATION OR WARRANTY OF ANY
KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR

http://www.boost.org/
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PURPOSE. 
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3.7 Supported File Types

PortraitPro Body can read and write the following types of files:

Type Extension Description

JPEG .jpg; .jpeg Image file type that uses lossy compression

TIFF .tif; .tiff Image file type that is uncompressed or uses loss-less compression

Note: TIFF files containing images that have 16 bits per color sample (48 bits
per pixel) are only supported in the Studio edition.

PNG .png Image file that uses loss-less compression 

PRB .prb Proprietary file type used by PortraitPro Body to store a session

Studio Edition

In addition, PortraitPro Body Studio supports reading the following camera RAW files:

Manufacturer Type

Adobe .dng

ARRI .ari

Canon .crw; .cr2

Epson .erf

Fuji .raf

Imacon .fff

Kodak .tif; .kdc; .dcr

Mamiya .mef; .mos

Minolta .mrw

Nikon .nef

Olympus .orf
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Panasonic .raw; .rw2

Pentax .ptx; .pef

Phase One .tif; .iiq

Red .r3d

QuickTake .qtk

Sigma .x3f

Sony .arw; .srf; .sr2
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3.8 Keyboard Shortcuts

PortraitPro Body provides the following keyboard shortcuts at the various stages of the application.

Menu Commands

CTRL+O File > Open command

CTRL+S File > Save Project command

CTRL+W File > Close command

CTRL+I File > Export image command

CTRL+Z Edit > Undo command

CTRL+Y Edit > Redo command

CTRL+A Edit > Animate command

Start Screen

CTRL+O Brings up File Open dialog to let you select the file to open

All modes

+ Zoom in

- Zoom out

CTRL Temporarily move to panning mode

1 Zoom to image

2 Zoom to body

3 Zoom to face

Editing modes

RETURN Flip to original when held

ENTER Flip to original when held

TAB Move to next brush

[ Make brush smaller

] Make brush larger

9 Make brush strength smaller

0 Make brush strength larger

SHIFT Temporarily switch to alternate tool
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Index
- A -
Arms     7, 23, 26, 30, 59, 65

- B -
Belly Button     20, 56

Brush     44

- C -
Curvy Slider     32, 65

- D -
Drag tool     7, 35, 70

- E -
Editions     10

- F -
Face     18, 43, 76

Female Torso     23, 59

File Menu     50

File Types     88

- G -
Gender     20

Group Shots     45

- H -
Homepage     48, 50

- J -
JPEG     50, 88

- K -
Keyboard Shortcuts     35, 52, 70, 90

- L -
Legs     7, 32, 56, 65

Lift Slider     32, 65

Lighting     43, 76

Lines     44

Lite Mode     15

- M -
Markup     18, 20, 23, 26, 56, 59

Menu Commands     48, 50, 90

- O -
Open Image     14, 15

Overlaps     7, 25, 26

- P -
Patches     44

Photoshop     10, 17, 82

Picture     43, 76

Black and White     45

Sepia     79

Plug-in     17, 82

PNG     10, 50, 83, 88

- Q -
Quick Start Guide     7

- R -
RAW     10, 35, 50, 70, 88

- S -
Save     7, 31, 48, 50, 51

Shape Tools     7, 9, 32, 62, 65
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Shape Tools     7, 9, 32, 62, 65

Bulges and Pinches     35, 70

Contract region     35, 70

Edit body local Tool     35, 70

Edit body Tool     35, 70

Expand Tool     35

Skeleton     7, 9, 20, 53, 56

Skin     7, 9, 39, 72, 76

Sliders     32, 35, 65, 70

Slim Slider     32, 65

Start     7

Support     6, 10, 50

- T -
Tall Slider     32, 65

TIFF     10, 50, 83, 88

Torso     7, 53

Tummy Tuck     39

- V -
View Menu     50, 52

- W -
Warp Fixer     44
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